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Zusammenfassung
In dieser Schritt-fiir-Schritt-Anleitung wird mit EDK ein minimales Rechnersystem
konfiguriert, die erforderlichen Datein fiir die Programmierung der Rechnerhardware in
den Logikschaltkreis und die Programmeintwicklung erzeugt. Dann wird SDK gestartet,
die Projektumgebung eingerichtet, ein kleines Programm zum Ausprobieren der Hardware
erstellt und mit diesem der entworfene Rechner ausprobiert.

1 Das zu entwerfende System

Abb. 1 zeigt die Blockstruktur des zu entwerfenden Rechnersystems. Es besteht aus dem Pro-
zessor, einem iiber lokale Speicherbusse (LMB’s) und entsprechende Controller angeschlossenen
Dualport-Speicher fiir die Befehle und Daten, einer iiber den AXI-Bus angeschlossene Aus-
gabgeschnittstelle fiir die Ansteuerung der Leuchtdioden auf der Baugruppe, einem iiber den
AXI-Bus angeschlossenen Debug-Controller und einer Riicksetzschaltung.

Takteingang Prozessor Businstanzen Schnittstellen-Controler Speicher
Microblaze (Prozessor) Imb_v10 Imb_bram_if_cntlr bram_block
DLMB (= —{SYS RST LISLMB  BRAM_PORT o PORTA
+—>{ LMBCLK
Clk CLK =
mb_v :
ILMB - 1 Imb_bram_if_cntlr
g = SLMB BRAM_PORT =~ PORTB
—1 MB_RESET L LMBOLK
L e mInEe axi_gpio (Ausgabeschnittstelle) | Ausginge
M-AXLDP > T.._ ARESETN S_AXI GBIO_I0O.O Led
DEBUG I.. ACLK |—> S_AXI_ACLK
= = L mdm (Debug-Controller)
proc_sys_reset (Riicksetzschaltung) S AXI Debug_SYS_Rst
—> Slowes_sync_clk Bus_Struct_Reset
1 Dcm_locked I.._aresetn MDDEBUG-0
> MB_Debug Sys Rst S_AXT_ACLK

Abbildung 1: Das zu entwerfende Rechnersystem

2 Hardware-Entwurf

Der System Builder von EDK ist in der Lage, das System fast vollstindig zu konfigurieren.
Der Rest ist manuell nachzubessern. Abb. 2 zeigt die Programmoberfliche von EDK und die
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auszuwiahlende Schaltfliche » New BSP-Project« fiir den Start des System Builders.

7/ Xilinx Platform Studio (EDK_P.68d) - no - 0] x|

File Edit View Project Hardware Device Configuration Debug =

[FaslpEesErlaalE@iz = |

Create Mew Project Using Base System Builder

Use the Base System Builder wizard to create an XPS _ILI
4

Abbildung 2: Startoberfliche von EDK

In dem sich 6ffnenden Fenster, Abb. 3, ist die Projektdatei und » AXI-System« auszuwéhlen.
Fiir jedes neue Projekt sollte ein eigenes Verzeichnis angelegt werden, was auch innerhalb des
Meniis moglich ist!. Die nicht gezeigten Auswahlfenster in der Abbildung darunter bleiben leer.
Weiter mit »Ok«.

/> Create New XPS Project Using BSB Wizard

| —Mew Project

Project File |C:\Softpr_-—; Benutzername=\BSP_AX|_Base\system.xmp

—Select an Interconnect Type

I + AXI System

AXIis an interface standard recently adopted by Xilinx as the standard interface used for
all current and future versions of Xilinx IP and tool flows. Details on AXI can be found in
the AXI Reference Guide on xilinx.com.

" PLB System
Abbildung 3: Festlegung des Arbeitsverzeichnisses und der Art des Bussystems

Im néchsten Fenster, Abb. 4, sind auszuwéhlen:

e »Create a System for a Custom Board« (Wir haben keines der auswéhlbaren Boards),
e der Typ des zu programmierenden Logikschaltkreises (spartan6, xc6slx16, ..),

e die Taktfrequenz 100 MHz, die Art des Riicksetzsignals (high-aktiv).

Fiir die nicht gezeigten Eintragsfelder sind die vorgegebenen Werte beizubehalten. Weiter mit
»Next«.

L Arbeiten Sie direkt auf Laufwerk C (statt auf einem Netzlaufwerk oder einem Stick) und sichern Sie sich
am Ende die wichtigen Dateien. Wenn Sie ein Netzlaufwerk verwenden, verldngert sich die Ubersetzungszeit um
einige Minuten.
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/i Base System Builder — AXI flow

—Board

" Create a System for the Following Development Board (Pre-selected Device Info)

Board Vendor I.‘(ilinx VI Board Name II(inte.\{-.'rr KC705 Evaluation Platform j Board Revision I?

& Create a System for a Custom Board

—Board Configuration

Architecture Ispar‘tanﬁ VI Device XC6sh16 Reference Clock Frequency |1DD.DD

Package Icsg324 'I Speed Grade |-2 'I Reset Polarity IActive High 'I ™ Use Steppin

—Select a System

Dual MicroBlaze Processor System

Single MicroBlaze Processor System System Information
’7This system consists of one instance of MicroBlaze with external mem

Abbildung 4: Auswahl des Systemtyps und des programmierbaren Logikschaltkreises

Im néchsten Fenster Abb. 5 wird die Blockspeichergrofe festgelegt, kann eine Gleitkom-
marecheneinheit (FPU) und konnen periphere Einheiten wie Speichercontroller, Timer, und
Schnittstellenschaltungen hinzugefiigt werden. Unser Minimalsystem soll nur eine Ausgabe-
schnittstelle fiir die acht Led’s auf der Baugruppe erhalten. Das Hinzufiigen erfolgt iiber » Add
Device«. Die weiterhin erforderlichen Bausteine (Debug-Controller, Prozessor, ...) werden ohne
explizite Auswahl eingefiigt.

/> Base System Builder - AXI flow 2| x|

Processor Frequency |1DD MHz j

— Processor Configuration

~Select a Processor ~ microblaze_0
microblaze_0 Enable Floating Point Unit ™
Local Memory Size |s ke |
Instruction Cache Size [s ke =l
Data Cache Size e ke 2

—Select and Configure Peripherals

Available Peripherals Included Peripherals for microblaze_0 Select All

Add Device...| Export... Import... | Core |Parameter
| LEDS

- 10 Devi e Core axi_gpio
evices Add =

Data Width 8 A
& Internal Peripherals I J

- axi_bram_ctr] < Remove | Use Interrupt r

axi_timebase_wdt
- axi_fimer

More Info | < Back Finish Cancel

Abbildung 5: Konfiguration des Systems

Peripheral Names

Nach »Finish« oOffnet sich im linken Fenster der »IP Catalog« und rechts die »System
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Assembly View / Bus Interfaces« (Abb. 6). In diese Ansicht kénnen weitere Komponenten und
Busse aus dem Bausteinkatalog zum Rechnersystem hinzugefiigt und und verbunden werden.
In unserem Projekt hat der »System Builder« bereits alle erforderlichen Bausteile ausgewihlt
und mit den richtigen Bussen verbunden. Wechsel zum Reiter »Ports.

Orfep|lewr@= £
IF Catalo.g «+08 X ALL \+ Bus Interfaces | Ports | Addresses
: }1{ r,é't' EI Name
- axifte_0
= £ EDK Instal - microbbze_0_dimb
& Analog - microblaze_0_imb
& Arithmetic - microblze_0
&- Bus and Bridge - microblBze_0_bram_block
- Clock, Reset and Interrupt & microblaze_0_d bram_cir!
& Communication High-Speed = microblze_0_i bram_ctrl
-- Communication Low-Speed & debug_module
- DMA and Timer & LEDS
& Debug - abck_generator_0
& FPGA Reconfiguration - - proc_sys_reset_0
1 | | 4 —Legend
WMaster #Slave dMaster/Slave B Target <Initiator @ Connected YUnconnected
Search IP Catalog: I Clear | Treroduction (Elicense (paid) (Sllicense (eval) SiLocal &iPre Production
! Superseded Discontinued
& Project @ IP Catalog | « Graphical Design View | & System Assembly View

Abbildung 6: Das konfigurierte System

In der Port-Ansicht, Abb. 7, sind die Eintrége fiir die externen Anschliisse (External Ports)
so noch nicht ganz richtig. Unser Rechnersystem bendtigt zum Testen keinen Reset-Eingang
und der 100MHz-Eingabetakt ist nicht {iber differentielle Eingénge, sondern nur iiber einen
Eingang an den FPGA angeschlossen. Die Ausginge zu den Leuchtdioden soll einfach nur
»Led« heiffen. Der Baustein »clock generator« ist in unserem Beispiel, in dem die Frequenz
des internen Takts gleich der des Eingangstakts ist, eine einfache Verbindung. Dieser Baustein
ist ohne Funktion und soll zur Vereinfachung weggelassen werden.

Name |C0nnected Port | Direction | Range |Class | Frequency(Hz)l
& External Ports

CLK N clock_generator_0::CLKIN L1 - CLK | 100000000

CLK F clock_generator_0::CLKIN 21 - CLK | 100000000

-~ LEDS_ TRL O LEDS::[gpio_0]::GPIO_IO_O fo ~|/0:77 NONE =

proc_sys_reset_0::Ext_Reset_In

r4
clock_generator_0::RST I v RST =

- axiEilite_0

- microbaze_0_dimb

- microbaze_0_imb

- microbaze_0

- microbaze_0_bram_block
- microbaze_0_d_bram_ctrl
- microbiaze_0_j_bram_citr!
- debug_modue

B LEDS

- clock_generator 0

B proc_sys_reset 0

Abbildung 7: Port-Ansicht nach der Konfiguration mit dem »System Builder«

Der einfachste Weg zur Nachbesserung ist, die externen Signale »CLK N«, »CLK P«
und »Reset« sowie den die Taktversorgung »clock generator 0« zu loschen, die Ausginge
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»LEDS TRI O« in »Led« umzubenenen und die dann fehlenden Verbindungen neu zuzuord-
nen. Loschen erfolgt durch Mausklick auf den Eintrag und »Delete external Port« bzw. » Delete
Instance and all its connections« und erfordert etwas Ubung und Geduld. Der neue Taktan-

schluss wird iiber einen Klick auf die Schaltfliche E[ oben rechts erzeugt. In das aufgehende
Menii in Abb. 8 ist der Anschlussnahme, hier »Clk«, die Signalflussrichtung, hier »I« fiir Ein-
gang/Input, und der Signaltyp, hier » CLK« fiir Takt einzutragen. Nach » Ok« ist in der Zeile
fiir den Takteintrag noch die Frequenz zu erginzen (siehe Abb. 9).

/% Connection Dialog x|

External Port Name ICIk

Direction [ |
Class cLk |
Net Mame ||

0K | Cancel |

Abbildung 8: Dialogfenster fiir das Anlegen externer Anschliisse

Namensédnderungen erfolgen durch Mausklick auf den alten Namen. Auch das erfordert etwas
Ubung und Geduld. Abb. 9 zeigt die fertig geéinderten Eintrige fiir die externen Anschliisse.

Name Connected Port | Direction | Range | Class | Frequency(Hz) | Differential Polarity
=i External P...

ck 21 - CLK ~| 100000000
-~ led  LEDS:[gpio_0]::GPIO_I0_O £ O ~| fo:7] NONE -

Abbildung 9: Geédnderte Eintrige fiir die externen Anschliisse

Das Entfernen der Taktversorgung und der externen Anschliisse hinterlisst offene Eingénge
an Bausteinen und entsprechende Fehlermeldungen beim »Design Rule Check« (Run DRCs).
An alle offenen Takteingénge (Eingénge der Klasse » CLK«) ist der externe Takt anzuschliefen.
In Abb. 10 ist fiir den Takteingang des AXI-Busses das Auswahlmenii fiir die Zuordnung des
Taktanschlusses geéffnet. Am Datenbus »microblaze 0 dlmb« darunter ist das Namensfeld
fiir den Taktanschluss noch leer, d.h. der Takteingang ist noch offen?.

Name |C0nnected Port | Direction |Range |Class |IP Type |D‘r|°fe| Sensitivity
E- External Ports
-k A1 il CLK il i
L Led LEDS::[gpio_0]::GPIO_I0_.O 4 O ~|/0:7] NONE =
=- axidite_0 1 axi..
M External Ports j Ci - I 'aHl
... INTERCONNE... proc_sys_reset_0:
& microbéze_0._dimb |/ %]
- LMB_CLK A1 CLK
L BYS_RST proc_sys_reset_0: :Bus_Struct_Red I RST
- microblze_0_imb 1 Im...

Abbildung 10: Neuzuordnung des Takts

Insgesamt muss der Takt neunmal angeschlossen werden. Die angeschlossenen Einheiten
und ihre Eingabetakte erscheinen auch als » Connected Ports« in der Beschreibungszeile des
externen Takteingangs (Abb. 11).

2Zum Editieren rechte Mouse-Taste auf die Kopfleiste mit Direction, ... und »Net« hinzufiigen.
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Name Connected Port |D'|recljon |Range |Cla$
E-External Ports

proc_sys_reset_0::Slowest_sync_ck 4
microblaze 0 _imb::LMB_CLK
microblaze_0_i_bram_ctrl::[SLMB]::LMB_Clk
microblaze 0 dimb::LMB_CLK

- Ok microblaze_0_d_bram_ctrl::[SLMB]::LMB_Clk I A CLK
microblaze_0::[DLMB:ILMB:M_AXT_DP:M_AXI_IP]::CLK
debug_module::[S_AXT]::5_AXI_ACLK
axidlite_0::[S_AXT CTRL]::INTERCONMNECT_ACLK
LEDS::[S_AXT]::S_AXI_ACLK

Abbildung 11: «Connected Ports« am Takteingang

An der Reset-Schaltung miissen aufer dem Takt zwei weiteren Eingingen Signalquellen
zugeordnet werden. In einem System ohne Reset-Taste ist das Signal »Ext Reset in« mit
dem logischen Wert null (net gnd) »Reset inaktiv« und der Eingang »DCM _lock« mit dem
logischen Wert eins (net vec) » Taktversorgung synchronisiert« zu verbinden (Abb. 12). Wenn
hier ein Fehler gemacht wird, bleibt der Prozessor dauerhaft riickgesetzt, so dass sich am Ende
des Software-Entwurfs kein Programm starten ldsst.

MName |Connected Port | Direction | Range |Cla$ |
= prog_sys_resef (0
- Slowest_sync_clk External Ports::Clk L1 CLK
- Ext_Reset_In net_gnd A1 RST
- AuX_Reset_In A1 RST
- MB_Debug_5Sys_Rst debug_module::Debug_SYS_Rst A1 RST
- Dem_locked net_vcc L1
- MB_Reset microblaze_0::MB_RESET ;_'_ o RST
microblaze_0_imb::SYS_RST &
Ll B HEda) microblaze_0_dimb::5YS_RST & =
- Peripheral_Reset o RST
- Interconnect_aresetn axidlite_0:: INTERCONNECT_ARESETN J_’: Q RST
- Peripheral_aresetn fo RST

Abbildung 12: Anschliisse an der Reset-Schaltung

Uber dem rechten grofen Fenster fiir die Systembeschreibung gibt es aufer » Bus Interfaces«
und »Ports« einen dritten Reiter » Adresses«. Uber diesen Reiter werden den Speichern und
den Registern der peripheren Bausteine Adressbereiche zugeordnet (Abb. 13). Die automatisch
generierten Einstellungen sind in Ordnung und verlangen keine Nachbesserung.

= Bus Interfaces | Ports  Addresses |

Instance Base Name | Base Address | High Address | Size | Bus Interface(s)l Bus Name Lock

E-microblaze_0's Address Map

- microblaze_0_d_bram_ctrl C_BASEADDR 0x00000000  0x00001FFF 8K  =|SLMB microblaze_0... [
- microblaze_0_i_bram_ctrl C_BASEADDR 0x00000000  0x00001FFF 8K  =|SLMB microblaze_0... [
LEDS C_BASEADDR  0x40000000 0x4000FFFF 64K |5 _AXI axidlite_0 [
- debug_module C_BASEADDR 041400000  Ox4140FFFF 64K = |S_AXI axidiite_0 O

Abbildung 13: Adresszuordnung

Im néchsten Schritt ist die ucf-Datei zu vervollstdndigen. Dazu ist unter dem Fenster mit
dem IP-Katalog der Reiter » Project« auszuwéhlen und im Baum »Project Files« die ucf-Datei
zu 6ffnen (Abb. 14). In der automatisch generierten Datei system.ucf steht nur drin, dass der
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Takt eine Frequenz von 100 MHz hat. Die Zuordnungen der Geh&useanschliisse darunter feh-
len und sind selbst einzutragen. Die Pinzuordnungen der in der Abbildung fehlenden Eintrége
fiir die Leuchtdioden 3 bis 7 sind in der »nexys3.ucf« auf der Web-Seite zu finden. Wichtig
ist, dass die Anschussnamen in der ucf-Datei mit denen der externen Anschliisse des Rechner-
systems iibereinstimmen. Zuordnungsfehler bewirken, dass Schaltungsanschliisse mit falschen
Gehduseanschliissen verbunden werden. Das wird zum Teil erst beim Programmstart oder der
Programmabarbeitung sichtbar.

Project wio @ 1 # automatisch generierte Eintrage

Platform - 2

= M=y 1-m — 3 -

Eliproject Files 3 NET 1K TNM_NET = SS:’S_Clk_pln.- .
*~ MHS File: system.mhs 4 TIMESPEC T3 sys clk pin = PERICD sys clk pin 100000 kHz;
UCF File: data\system.ucf 5
MPACT Command File: etc/dc 6 # selbst zu erganzen
-~ Implementation Options File: ¢ 7 NET "Clk" LOoC = "v10" | IOSTANDARD =
-~ Bitgen Options Fle: etc/bitger 8 NET <0 LOC = "Ulé"™ | IOSTANDARD =
B Eff Fies " 9 NET LOC = "V16" | IOSTANDERD =

i E-microblaze_0 10 NET LOC = "U15" | IOSTANDERD =

Abbildung 14: Navigator, Projektdateibaum und ucf-Datei

Die fertige Hardware-Beschreibung steht in der Datei »system.mhs« im Project-File-Baum
direkt tiber der ucf-Datei und kann gedffnet, gelesen und editiert werden (Abb. 15). Von dem
gesamten bisherigen Entwurf geniigt es, die mhs- und die ucf-Datei aufzubewahren (siehe An-
leitungen fiir die Hardware-Erweiterung des Minimalsystems.

Links neben den »Project Files« befinden sich die Icons der Werkzeuge fiir die Schaltungs-
erzeugung aus der bis hierher erstellten Konfigurationsbeschreibung. Mit » Run DRLs« wird
der »Design Rule Check« gestartet. Dieser kontrolliert die Konfiguration des Rechnersystems
auf Zuléssigkeit. Er erkennt z.B. offene Takt- und Reset-Eingéinge. Sind alle mit » Run DRLs«
erkennbaren Fehler beseitigt und wurde fiir alle moglicherweise noch vorhandenen Warnun-
gen kontrolliert, das sie als ignorierbar gelten®, kann der Generierungsprozess mit » Generate
Netlist«, » Generate BitStream« und »Export Design« fortgefiihrt und abgeschlossen werden.

Navigator 3£ | Project

T |
. = Prn]ect Files

E ® MHS File: system.mhs
: - UCF File: data\system.ucf
Run DRCs - IMPACT Command File: etc/download.cmd
- Implementation Options Fie: etc/fast_runtime.opt

- Bitgen Options File: etc/bitgen.ut
O L EFFi
% = Eff Files
- - microblaze_0
Generate Netlist
=8 Pm]ect Options
- Device: xcbslx16cs9324-2
- Netlist: TopLevel
- Implementation: XPS (Xflow)
- HDL: VHDL
-~ 5im Model: BEHAVIORAL
Desngn Summary

Generate BitStream

6

Export Design

Abbildung 15: Navigator, Projektdateibaum und ucf-Datei

3Tgnorierte Warnungen bei » Run DRLs« sind oft Ursache fiir Fehlfunktionen bei der spiiteren Inbetriebnahme
und beim Softwaretest. Es empfielt sich, dazu auffindbare FAQ-Seiten zu studieren. Gefahrenlos ignorierbar sind
in der Regel Warnungen, das Lizenzen abgelaufen oder Ausginge ungenutzt sind.
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Die Werkzeuge miissen nicht einzeln aufgerufen werden. » Export Design« mit angekreuztem
»Include bitstream and ...« startet alle Bearbeitungsschritte nacheinander (Abb. 16). Mit »Ex-
port only« werden die drei Ergebnisdatein des Hardware-Entwurfs fiir den Software-Entwurf
nur gespeichert bzw. iiberschrieben. » Export & Launch SDK« startet zusétzlich die Software-
Entwicklungsumgebung SDK.

[ Export to SDK / Launch SDK FdEd
@ This dialog allows you to export hardware
platform information to be used in SDK.
¥ Include bitstream and BMM file
(¥PS will regenerate bitstream if necessary,

and it may take some time to finish.)

Directory location for hardware description files

| H:\Softprozessor\BSP_AXI Base\SDK\SDK_Export

Export Dnlyl Export & Launch SDK Cancel Help

Abbildung 16: Auswahlfenster fiir den Export

Beim Export und beim Start von SDK ist der Pfad fiir das Software-Projekt anzugeben
(Abb. 17). Das sollte bei einem neuen Projekt ein neu angelegtes leeres Verzeichnis sein.

10" Workspace Launcher x|

Select a workspace

Tyt H - \Softprozessor\SW_BSP_AXT_BASH

[~ Use this as the default and do not ask again

Abbildung 17: Festlegung des Pfads fiir das Software-Projekt

SDK héngt sich, wenn es so gestartet wird, gern mit einer Java-Fehlermeldung auf. Dann ist
entweder » Export & Launch SDK« noch einmal aufzurufen, aber ohne den Haken bei » Include
bitstream and ...« oder SDK ist direkt zu starten. Abb. 18 zeigt das Icon von SDK und den
Pfad, unter dem es im Startmenii

Start > All Programms

zu finden ist. Beim direkten Start ist der in Abb. 17 festgelegte Workspace auszuwéhlen.

3 Uberspringen des Hardware-Entwurfs
Das Ergebnis des Hardware-Entwurfs steht in drei Dateien:
e bit-Datei: Download-File zur Programmierung der Hardware-Funktionalitét

e bmm-Datei: Informationen fiir den Download des Programms und
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Xiinx Design Tools
ISE Design Suite 14.6
Accessories
ChipScope Pro
Documentation
EDK
& Xiinx Platform Studio

@& Xiinx Software Development Kit

Abbildung 18: Tcon und Pfad fiir den direkten Start von SDK

e xml-Datei: Informationen, die die Treiber iiber die Hardware brauchen.

Fiir den im vorherigen Abschnitt beschrieben Entwurf stehen diese drei Dateien auf der Web-
Seite und sind in ein Verzeichnis auf dem Rechner, z.B. »Download« herunterzuladen. Das
Entwurfssystem SDK ist normal zu starten und in dem sich &ffnenden Fenster genau wie in
Abb. 17 ein neues leeres Verzeichnis als » workspace« auszuwéhlen. Die Auswahl der » Hardware
Platform Specification« erfolgt iiber

File > New > Project

und dann weiter mit dem Auswahlfenster Abb. 19 und » Next«.

2 newproject o] x]

Select a wizard

H-i= General
B CfC++
=G Xinx
&) Application Project
il Board Support Package
(S Ee] Hardware Platform Spedification

?) = Back I Next = I Firsh | Cancel

Abbildung 19: Festlegung des Pfads fiir das Software-Projekt

Im n#chsten Fenster, Abb. 20, ist die xml-Datei auszuwéhlen. Die Auswahl von »Bitstream
and BMM Files« darunter, erfolgt, wenn sie im selben Verzeichnis stehen, automatisch. Nach
»Finish« wird der Objektbaum fiir die » Hardware Platform Specification« in derselben Weise
wie bei einem Export aus EDK eingerichtet.

4 Software-Entwurf

Nach »Export & Launch SDK« aus EDK bzw. nach »Finish« im Abschnitt zuvor enthilt der
Objektbaum im »Project Explorer« in Abbh. 21 den Teilbaum mit den Dateien zur Beschreibung
der Hardware: das bit-File zur Programmierung der Hardware-Funktionalitit, das xml-File mit
den Hardware-Adressen und Konstanten fiir die Treiber und das bmm-File, in dem steht, aus
welchen Block-RAMs der Befehls- und Datenspeicher zusammengesetzt ist.

Vor dem Entwurf des ersten Anwendungsprogrammes ist ein » Board Support Package« mit
den hardware-nahen Funktionen und Treibern zu erzeugen. Uber
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_io/x|

Project name: | BSP_AXT_Base_hw_platform

[¥ Use default location
Target Hardware Specification

| C:\Users\gkemnitz\Downloads\system.xml

» Bitstream and BMM Files

@ < Back [+t = Finish | Cancel |

Abbildung 20: Auswahl der Dateien zur Beschreibung der Hardware

I x|

File Edit | Source Refactor Mawvigate Search Run Project  Hiinx Tools  Window  Help

Jf‘jv 3w - J@vﬁﬁvﬁv@vJ:};@;vﬁv%va\JE ﬁ%cﬁc_‘_*_
|20 | & |®~~ | el vyt Y oy
[t5 Project Explorer 2 = B E'WEE ou B\ @Mal"

= ' - =
B&|¥ {2 Problems fsé. Tasks Mﬁl Properljesw B Terminal ﬂ

EHS B_‘S.P_A}G_Base_hw_platform SDK Log = Eﬁ| = & ~ %
= system_bd.bmm
:z\Softprozessor\BSP_AXI Base\SDK\SDK_Export\hw\system.xml

-5 system.bit
|3 system.xml

Abbildung 21: Projektbaum mit der » Hardware Platform Specification«

File > New > Board Support Pakage

offnet sich das Fenster in Abb. 22. In ihm ist »standalone« auszuwéhlen (Entwicklung von An-
wendungsprogrammen, die allein ohne Betriebssystem auf dem Prozessor laufen). Im néchsten
Fenster ist keine der angebotenen Bibliotheken auszuwéhlen. Abschluss mit » Ok«.

1" New Board Support Package Project — |EI |i|

Project name: | standalone_bsp_0|

[¥ Use default location
~ Target Hardware

Hardware Platform: IBSP_AXI_Base_hw_platform ﬂ

CPU: Imicroblaze_[l ﬂ

~Board Support Package 0S5

xilkernel Standalone is a simple, low-level software layer. It provides access
0 basic processor features ...

(?) .. Finish I Cancel

Abbildung 22: Einrichtung des Board Support Packages

Abb. 23 zeigt den Objektbaum mit dem erzeugten »Board Support Package«. Fiir die
Entwicklung der Anwendungsprogramme sind vor allem die Header im Include-Verzeichnis
des Prozessors wichtig. Die hardware-spezifischen Adressen und Konstanten sind hier alle als
Makros im Header »xparameters.h« zu finden. »XPAR_LEDS BASEADDR« mit dem Wert
0x400000000000 ist z.B. die Ausgabeadresse an die Leuchtdioden.
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| Project Explorer £3 = O

>
i

[, system.mss f@ xparameters.h 2

BE|w T

{3 BSP_AXI_Base_hw_platform
=l standalone_bsp_0

i BSP Documentation
é---[& microblaze 0

---[5 include
[Zb ib
---[5 ibsrc
----- |5/ lbgen.log
----- |5/ ibgen.options
----- Makefie

=5
#define XPAR_UARTLITE_@ DATA_BITS 8 a4
#define XPAR_UARTLITE_© SIO_CHAN -1

|

f'ﬂ==C=(==C=(==C=(==C=(==C=(==C=(==C=(KHKHKHKHKHKHKHKHKHKHKHK

/* Definitions for driver GPIO */
#define XPAR_XGPIO NUM_INSTANCES 1

/* Definitions for peripheral LEDS */
#define XPAR_LEDS BASEADDR @x40000000
#define XPAR_LEDS HIGHADDR @x4000FFFF
#define XPAR_LEDS DEVICE ID @

#define XPAR_LEDS INTERRUPT _PRESENT @
#define XPAR_LEDS IS DUAL @

11

Abbildung 23: Projektbaum mit Board Support Package und der Header »xparameters.h«

Nach all den vorbereitenden Schritten kann nun endlich die eigentliche Software-Entwicklung
beginnen. Die Einrichtung eines Software-Projekts erfolgt iiber:

File > New > Application Project

In dem sich &6ffnenden Fenster, Abb. 24, ist dem Projekt ein Name zu geben, die Program-
miersprache festzulegen sowie eine » Hardware Plattform« und ein »Board Support Package«
zuzuordnen. Dann geht es mit » Next« zum nédchsten Menii.

Project name: | Haloweld
[¥ Use default location

1ol x|

~Target Hardware
Hardware Platform |BSP_A}G_Base_hw_platf0rm j
Processor | microblaze_0 j
~ Target Software
05 Platform Istandalone ﬂ
Language @ Ci C++
Board Support Package ( Create New |
& Use existing |standabne_bsp_[l j
2 = Back | Wext > | Firfisti I Cancel |

Abbildung 24: Einrichten eines Software-Projekts

Im néchsten Menii, Abb. 25, wird als Vorlage »Hello World« ausgewiahlt und das Anlegen
des » Applikation Projects« mit »Finish« abgeschlossen. Ergebnis ist der dritter Projektbaum
in Abb. 26 mit dem Namen des » Application Projects« und dem »helloworld «-Programm.

Das originale Helloworld-Programm schreibt auf die Standardausgabe den Text »Hello
World« und beendet sich. Die Zeile mit der Ausgabe der Konstanten 0xB3 an die Leucht-
dioden ist manuell eingefiigt. »Xio Out8()« ist im Header »xio.h« und die Ausgabeadresse
»XPAR_LEDS_ BASEADDR« in »xparamerters.h« definiert. Das Ubersetzen erfolgt beim
Speichern. Bei der Fehlermeldung, dass der Ubersetzer »XPAR LEDS BASEADDR« oder
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_io/x|

Available Templates:
Let's say 'Hello World' in C. N
Memory Tests
SREC Bootloader =l

@) < Back | et = | Finish I Cancel |

Abbildung 25: Auswahl der Vorlage » Hallo Welt«

»Xio_Out8()« nicht kennt, fehlt entweder die Inculde-Anweisung fiir den entsprechenden Hea-
der oder der Pfad zum »Board Support Package«. Im letzten Fall empfliehlt es sich, das » Ap-
plication Project« aus dem Projektbaum zu entfernen, den zugehorigen Verzeichnisbaum zu
16schen und das » Application Project« nochmal richtig anzulegen.

[t Project Explorer 2 = B[ [n xparameters.h w’z
AE|T T #include <stdio.h>
=-{3F BSP_AXI_Base_hw_platform #include “"platform.h”
=2 HalloWelt // Header fir die LED-Ausgabe
--1*,3‘ Binaries #include <xparameters.h>
@) Indudes #include <xio.h>
"'Eb Debug void print(char *str);
== src : :
: = int main(){
e [retinennl init_platform();

[¢ platform.c

-8 platform.h print("Hello Worldi\n\r"};

XTo_Out8(XPAR_LEDS_BASEADDR, @xB3);
return 0;

-l standalone_bsp_0 3

Abbildung 26: Vollstandiger Projektbaum und Anwendungsprogramm

Vor dem Start des Programms ist das Bitfile zur Konfiguration der Rechner-Hardware {iber

das Menii
Xilinx Tools > Program FPGA

in den Schaltkreis zu laden. Dabei 6ffnet sich das Menii in Abb. 27, in dem nur »Program«
anzuklicken ist. Falls der Download nicht klappt, ist zu kontrollieren, dass die Baugruppe Strom

4 Program FPGA x|

~Hardware Configuration
Hardware Specification: H:\Softprozessor\SW_BSP_AXI_BASE\BSP_AXI Base hw_platform\system.xml
Bitstream: | H:\Softprozessor\SwW_BSP_AXI_BASE\BSP_AXI_Base_hw_platform\system.bit Browse.. |

BMM File: |H:‘..Sof'tprozessor\SW_BSP_AXI_BASE\BSP_A}G_BE!se_hw_platform\.system_bd.bmm Brmvse..l

~Software Configuration
Processor | ELF Fie to Initialize in Block RAM |
microblaze_0  bootloop |

@:l Program I Cancel

Abbildung 27: Programmieren der FPGA-Hardware
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H

3= =+

SRER NS Name: | HalloWelt Debug

| type fitter text Main . " Device Initializatio | “.» STDIO Connection | 3
~[E] C/C++ Application C/C++ Application:

...... [c] C/C++ Remote Application

| Debug\Hallowwelt.elf

------ = Launch Group

----- $#7 Remote ARM Linux Application Project:

[E Target Communication Framework | HalloWelt Brows

E---G% Xilinx CfC++ application (GDB)
% Hallowel Debug

Build (if required) before launching
’7 Build configuration: |Debug

Abbildung 28: Grundeinstellungen der » Run Configuration«

hat, angeschaltet und das Programmierkabel angeschlossen ist. Manchmal helfen auch mehrere
Versuche, abziehen und wiederanstecken des Programmier-USB-Kabels und vor allem Geduld.
Abschliefsend ist {iber das Menii

Run > Run Configurations..> »Xilinx c¢/C++ applicatiion (GDB)

mit einem Rechtsklick auf »Xilinx ¢/C++ applicatiion (GDB)« eine » Launch Configuration« zu
erzeugen. Unter dem Reiter » Main« bekommt diese einen Namen, ein Projekt, ein ausfiihrbares
Programm, ... zugeordnet (Abb. 28). In unserem Projekt ist nur unter dem Reiter » STDIO
Connection« eine Anderung erforderlich (Abb 29). Hier ist » Connect STDIO to Console« und
als Port » JTAG UART « auszuwéhlen.

Name: | HalloWelt Debug

(12 Main [%~ Source [~ Device Initialization |- STDIO Connection
[+ Connect STDIO to Console

e il TAG UART [

Abbildung 29: Verbindung der Standardausgabe mit der Konsole

Der Programmstart erfolgt mit » Run« bzw. iiber die Schaltfliche @. Nach Laden und Pro-
grammstart gibt unser Beispielprogramm auf der Konsole den Text »Hello World« aus (Abb.
30). Das Ausgabebitmuster auf den Leuchtdioden ist »1100 1101« (der bitgespiegelte Wert zu
0xB3).

El Console 3 v Tasks} 4 Terminal 11[3_\ Problems] o Executabﬁ] X %| xellgeE| B0
=<terminated= Test1.elf [Xiinx C/C++ application (GDB)] H:\Softprozessor\SW_BSP_AXI_BASE\Test1\Debug\Test1.elf [Console connected to JTAG UART]
| Hello World 4]

Abbildung 30: Testausgabe auf der Console



